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Q.1 Select the most appropriate adjective to fill in the blank.

The public speaker's speech was , leaving the audience deeply moved.
Ans ¢ A inspirational

/X B. forgettable
X C. disjointed

#< D. monotonous

Question Type : MCQ
Question ID : 6306801044923
Option 11D : 6306804101835
Option 21D : 6306804101832
Option 3 ID : 6306804101834
Option 4 ID : 6306804101833
Status : Answered
Chosen Option : D
Marks : -0.25

Q.2 Select the proverb that can substitute the underlined phrase in the given sentence.

The after-school art club was a magnet for students who loved to draw and paint. As
the saying goes, people with similar interests tend to find each other.

Ans X A. opposites attract
«” B. birds of a feather flock together
&5 C. there's no place like home

#5 D. great minds think alike

Question Type : MCQ
Question ID : 630680735717
Option 11D : 6306802883589
Option 2 ID : 6306802883587
Option 3 ID : 6306802883588
Option 4 ID : 6306802883590
Status : Answered
Chosen Option : C
Marks : -0.25
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given sentence.

Mr. Trivedi running every morning.

Q.3 Select the most appropriate option that can substitute the highlighted word in the

Ans X A.run
” B.runs
#< C.runned
< D.ran
Question Type : MCQ
Question ID : 6306801051710
Option 11D : 6306804129258
Option 2 ID : 6306804129257
Option 3 1D : 6306804129260
Option 4 ID : 6306804129259
Status : Answered
Chosen Option : B
Marks : 1
Q4 Select the option that corrects the usage of the homonym in the given
sentence.
The mountain pique was steep and challenging for trekking.
Ans X' A The mountain peek was steep and challenging for trekking.
«” B. The mountain peak was steep and challenging for trekking.
#< C. The mountain pick was steep and challenging for trekking.
#¢ D. The mountain peke was steep and challenging for trekking.
Question Type : MCQ
Question ID : 6306801045398
Option 11D : 6306804103717
Option 21D : 6306804103716
Option 3 ID : 6306804103718
Option 4 1D : 6306804103719
Status : Answered
Chosen Option: C
Marks : -0.25
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Q.5 Select the most appropriate option to fill in the blank.
After the roller coaster ride, everyone emerged from the car feeling , while
laughing about the wild twists and turns.
Ans A giddy
& B. conscious
&5 C. wholesome
# D. empty
Question Type : MCQ
Question ID : 6306801047082
Option 11D : 6306804110442
Option 2 1D : 6306804110444
Option 3 ID : 6306804110445
Option 4 1D : 6306804110443
Status : Answered
Chosen Option : B
Marks : -0.25
Q.6 Which word is INCORRECTLY spelt in the given sentence?
The orchestra's perfomance of the symphony was met with thunderous applause.
Ans  # A perfomance
#< B. thunderous
# C. symphony
#< D. orchestra's
Question Type : MCQ
Question ID : 630680751835
Option 11D : 6306802946750
Option 2 1D : 6306802946752
Option 3 ID : 6306802946751
Option 4 ID : 6306802946749
Status : Answered
Chosen Option : B
Marks : -0.25
Q.7 Select the most appropriate meaning of the given proverb.
A fool and his money are soon parted.
Ans X A. Money owned by a fool stays on with him for a long time as he doesn’t know how to
spend it
¢ B. Aperson who is not sensible usually loses his money
# C. Afool earns a lot of money but cannot save it from thieves
#5 D. Afool spends his money by giving parties
Question Type : MCQ
Question ID : 630680757013
Option 11D : 6306802967011
Option 21D : 6306802967008
Option 3 ID : 6306802967010
Option 4 1D : 6306802967009
Status : Answered
Chosen Option : B
Marks : 1
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and balance.

Q.8 Select the most appropriate pair of homonyms to fill in the blanks.

Samaira was ready to

Ans X A. except; accept
5 B. except; except
o C. accept; except

#5 D. accept; accept

the teachings of yoga for both body and mind,
the strict practices that didn’t resonate with her approach to mindfulness

Question Type : MCQ
Question ID : 6306801058344
Option 11D : 6306804155748
Option 21D : 6306804155749
Option 3 ID : 6306804155750
Option 4 ID : 6306804155747
Status : Answered
Chosen Option : C
Marks : 1
Q.9 Select the most appropriate meaning of the given proverb.
An empty vessel makes much noise
Ans X A. Not to getinvolved in an unknown issue
/5 B. Alady quarrels in the kitchen
o C. Fools often talk a lot
/X D. Big utensils create much sound
Question Type : MCQ
Question ID : 630680745557
Option 11D : 6306802922423
Option 21D : 6306802922426
Option 3 ID : 6306802922425
Option 4 ID : 6306802922424
Status : Answered
Chosen Option: C
Marks : 1
Q.10 Select the most appropriate option to fill in the blanks.
| completed my work, went to my room and read a book for half an hour. books |
read are full of suspense and thrill. That is most relaxing time of my entire day.
Ans X A A a
X B.A, the
< C.An, the
o D. The, the
Question Type : MCQ
Question ID : 63068080482
Option 11D : 630680311956
Option 21D : 630680311953
Option 3 ID : 630680311955
Option 4 ID : 630680311954
Status : Answered
Chosen Option : A
Marks : -0.25
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Q.11 Select the option that expresses the given sentence in indirect speech.

The police said to the man, “Who are you? Where do you come from?”
Ans ¢ A The police asked the man who he was and where he came from.

5 B. The police ask the man who he was and where he came from.
&5 C. The police ask the man who are you, where did you come from.

#5 D. The police asked the man who are you, where do you come from.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :

1 6306801157143

Status :

Chosen Option :

Marks :

Option 4 ID

McQ
630680297421
6306801157145
6306801157144
6306801157146

Answered
D
-0.25

Q.12 Select the most appropriate adjective to replace the underlined word in the given
sentence.

The delicious weather made the picnic enjoyable.
Ans X A. savoury

< B. horrible
o C. pleasant
&5 D. dreadful

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCQ
6306801045095
6306804102523
6306804102520
6306804102521
6306804102522
Answered

Cc

1
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Despite his
need.
Ans X A.avaricious
5 B. capricious
#< C. vicarious

¢ D. penurious

Q.13 Select the most appropriate option to fill in the blank.

condition, marked by extreme poverty and lack of
resources, he maintained a generous spirit and always found ways to help those in

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
6306801056014
6306804146567
6306804146566
6306804146569
6306804146568
Answered

B

-0.25

Indifference
Ans X A.Hatred

# B. Apathy

X D. Dislike

Q.14 Select the most appropriate ANTONYM of the given word.

¢ C. Enthusiasm

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
630680727287
6306802849940
6306802849937
6306802849938
6306802849939
Answered

B

-0.25

Ans X A humility
& B. spirituality
< C. hatred
o D. goodwill

She is very popular as she bears no malice towards anyone.

Q.15 Select the most appropriate ANTONYM of the underlined word in the given sentence.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680685154
6306802683118
6306802683119
6306802683116
6306802683117
Answered

Cc

-0.25
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Q.16 Select the most appropriate option to fill in the blank.

A sudden downpour the quiet village fair into a chaotic carnival.
Ans X A.turning

< B.turn
#< C. be turned

¢’ D. turned
Question Type : MCQ
Question ID : 630680560542
Option 11D : 6306802191146
Option 2 ID : 6306802191144
Option 3 ID : 6306802191147
Option 4 ID : 6306802191145
Status : Answered
Chosen Option : B
Marks : -0.25
Q.17 Select the most appropriate ANTONYM of the underlined word.
Abhishek evinced great enthusiasm for working on that ambitious project.
Ans X A.Examined
«” B. Concealed
& C. Demonstrated
< D. Proved
Question Type : MCQ
Question ID : 630680728440
Option 11D : 6306802854520
Option 2 ID : 6306802854517
Option 3 ID : 6306802854518
Option 4 ID : 6306802854519
Status : Answered
Chosen Option: C
Marks : -0.25
Q.18 Select the most appropriate option to fill in the blank.
During a morning walk, early riser enjoyed a fresh breeze and an invigorating
sunrise, making it perfect start to the day.
Ans X A an;an
¢’ B.an; a
& C.a;an
X D.aja
Question Type : MCQ
Question ID : 6306801047070
Option 11D : 6306804110397
Option 2 1D : 6306804110396
Option 3 ID : 6306804110395
Option 4 ID : 6306804110394
Status : Answered
Chosen Option : B
Marks : 1
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Q.19 Select the most appropriate meaning of the given proverb.
A goose quill is more dangerous than a lion’s claw

Ans X A.Agoose is more powerful than a lion
#€ B. One should not fight with a goose
& C. Inconsiderate words are more painful than physical attacks

€ D. One should not fight with a powerful person

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680790180
6306803096501
6306803096500
6306803096502
6306803096503
Answered

(4

1

Q.20 Select the INCORRECTLY spelt word in the given sentence.

Ans X A. horrified
¢’ B. abandond
#< C. forensic
< D. mutilated

The forensic team was horrified to see the mutilated remains in the abandond house.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 3D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
630680805606
6306803156082
6306803156084
6306803156081
6306803156083
Answered

B

1

Sharda told me that she was going to her village.
Ans X A. Sharda says, "l will go to my village."

4 B. Sharda said, "I'm going to my village."
# C. Sharda said, "l was going to a village."
#< D. Sharda said, "She is going to her village."

Q.21 Select the option that expresses the given sentence in direct speech.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
630680721873
6306802828784
6306802828782
6306802828785
6306802828783
Answered

D

-0.25
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Q.22 Select the most appropriate meaning of the given proverb.

If it ain’t broke, don’t fix it.
Ans X A. Fix things even if they work fine.

5 B. Breaking things is necessary to fix them.
&5 C. Fixing things is important.

«” D. Don’t change something that’s working well.

Question Type : MCQ
Question ID : 6306801046019
Option 11D : 6306804106160
Option 21D : 6306804106162
Option 3 ID : 6306804106163
Option 4 ID : 6306804106161
Status : Answered
Chosen Option : B
Marks : -0.25
Q.23 Identify the INCORRECTLY spelt word in the given sentence.
The weather forecaster predicted rain for tommorow.
Ans X A.forecaster
«” B. tommorow
< C. weather
5 D. predicted
Question Type : MCQ
Question ID : 630680754731
Option 11D : 6306802958124
Option 2 ID : 6306802958126
Option 3 ID : 6306802958123
Option 4 ID : 6306802958125
Status : Answered
Chosen Option : B
Marks : 1
Q.24 Select the most appropriate ANTONYM of the word highlighted in bold in the given
sentence.
The new law to impose a ban on tobacco is to curb health hazards associated with
smoking and chewing of tobacco.
Ans  # A Increase
& B. Limit
# C. Control
#5 D. Decrease
Question Type : MCQ
Question ID : 630680805414
Option 11D : 6306803155341
Option 21D : 6306803155343
Option 3 ID : 6306803155344
Option 4 ID : 6306803155342
Status : Answered
Chosen Option : B
Marks : -0.25
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Q.25 Select the most appropriate ANTONYM of the highlighted word.

Ans X A Resistless
&5 B. Woozy
¢” C. Strong
5 D. Kind

This type of organisation is rare at present, and there is a general belief that too high a
proportion of mentally infirm people can undermine the effectiveness of relief care.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :

Option 4 ID

: 6306804559108
Status :
Chosen Option :
Marks :

MCcQ

6306801159907
6306804559107
6306804559110
6306804559109

Answered
C
1
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Comprehension:
Read the passage carefully and answer the questions that follow.

One of the hallmarks of Roald Dahl's writing style is its simplicity. His prose is clear, concise
and utterly engaging. Dahl masterfully crafts stories that are accessible to readers of all ages
without sacrificing depth or emotional resonance. His choice of words is precise, making it
easy for young readers to grasp the narrative, while still providing a rich reading experience
for adults.

In ‘Matilda’, Dahl introduces us to a brilliant young girl with telekinetic powers. Through Dahl's
straightforward prose, we enter Matilda's world effortlessly. 'It's a funny thing about mothers
and fathers. Even when their own child is the most disgusting little blister you could ever
imagine, they still think that he or she is wonderful', reads one of the endearing quotes in the
book 'Matilda'. Dahl's ability to address complex themes, such as neglect and injustice,
through simple language is a proof of his storytelling intelligence.

In the iconic ‘Charlie and the Chocolate Factory', Dahl invites us into Willy Wonka's candy-
filled wonderland. His descriptions of the factory are brimming with imagination, 'The walls
and ceiling were covered with large patches of something that looked like thick, brown fur
carpet. In the places where there were no patches of fur, there were large splodges of a
revolting greenish mold'. Dahl's vivid imagery allows readers to visualise Wonka's eccentric
world, making it a memorable reading experience.

While Roald Dahl's tales are filled with whimsy and fantasy, they are embraced with important
life lessons. Dahl uses his simple prose to convey messages of kindness, resilience and the
triumph of good over evil. In ‘The Witches', Dahl addresses themes of courage and
resourcefulness as a young boy battles a coven of witches. Dahl's straightforward language
carries a powerful message, 'You are using the bravery of a small boy and the intelligence of
a mouse to defeat your enemy. And you are doing it brilliantly'. Dahl's ability to blend simplicity
with profound themes makes his stories not only enjoyable but also impactful.

SubQuestion No : 26

Q.26 Based on the passage about Roald Dahl's writing, which of the following options is
correct about the story "'The Witches'?

Ans X A lt's a lighthearted tale about the joys of friendship and cooperation.

«” B. It's a suspenseful adventure where a young boy confronts a dangerous threat.
#5 C. It's a humorous story about a young witch learning her craft.

#5 D. It's a complex story exploring human relationships.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCcQ
630680805371
6306803155177
6306803155179
6306803155180
6306803155178
Answered

B

1
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Ans

Comprehension:
Read the passage carefully and answer the questions that follow.

One of the hallmarks of Roald Dahl's writing style is its simplicity. His prose is clear, concise
and utterly engaging. Dahl masterfully crafts stories that are accessible to readers of all ages
without sacrificing depth or emotional resonance. His choice of words is precise, making it
easy for young readers to grasp the narrative, while still providing a rich reading experience
for adults.

In ‘Matilda’, Dahl introduces us to a brilliant young girl with telekinetic powers. Through Dahl's
straightforward prose, we enter Matilda's world effortlessly. 'It's a funny thing about mothers
and fathers. Even when their own child is the most disgusting little blister you could ever
imagine, they still think that he or she is wonderful', reads one of the endearing quotes in the
book 'Matilda'. Dahl's ability to address complex themes, such as neglect and injustice,
through simple language is a proof of his storytelling intelligence.

In the iconic ‘Charlie and the Chocolate Factory', Dahl invites us into Willy Wonka's candy-
filled wonderland. His descriptions of the factory are brimming with imagination, 'The walls
and ceiling were covered with large patches of something that looked like thick, brown fur
carpet. In the places where there were no patches of fur, there were large splodges of a
revolting greenish mold'. Dahl's vivid imagery allows readers to visualise Wonka's eccentric
world, making it a memorable reading experience.

While Roald Dahl's tales are filled with whimsy and fantasy, they are embraced with important
life lessons. Dahl uses his simple prose to convey messages of kindness, resilience and the
triumph of good over evil. In ‘The Witches', Dahl addresses themes of courage and
resourcefulness as a young boy battles a coven of witches. Dahl's straightforward language
carries a powerful message, 'You are using the bravery of a small boy and the intelligence of
a mouse to defeat your enemy. And you are doing it brilliantly'. Dahl's ability to blend simplicity
with profound themes makes his stories not only enjoyable but also impactful.

SubQuestion No : 27

Q.27 Select the most appropriate meaning of the word ‘endearing’ as given in the passage.

& A. Inspiring love or affection

5 B. Creating a sense of insecurity
#5 C. Causing harm or injury

#< D. Provoking anger or irritation

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680805372
6306803155182
6306803155183
6306803155181
6306803155184
Answered

Cc

-0.25
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Comprehension:
Read the passage carefully and answer the questions that follow.

One of the hallmarks of Roald Dahl's writing style is its simplicity. His prose is clear, concise
and utterly engaging. Dahl masterfully crafts stories that are accessible to readers of all ages
without sacrificing depth or emotional resonance. His choice of words is precise, making it
easy for young readers to grasp the narrative, while still providing a rich reading experience
for adults.

In ‘Matilda’, Dahl introduces us to a brilliant young girl with telekinetic powers. Through Dahl's
straightforward prose, we enter Matilda's world effortlessly. 'It's a funny thing about mothers
and fathers. Even when their own child is the most disgusting little blister you could ever
imagine, they still think that he or she is wonderful', reads one of the endearing quotes in the
book 'Matilda'. Dahl's ability to address complex themes, such as neglect and injustice,
through simple language is a proof of his storytelling intelligence.

In the iconic ‘Charlie and the Chocolate Factory', Dahl invites us into Willy Wonka's candy-
filled wonderland. His descriptions of the factory are brimming with imagination, 'The walls
and ceiling were covered with large patches of something that looked like thick, brown fur
carpet. In the places where there were no patches of fur, there were large splodges of a
revolting greenish mold'. Dahl's vivid imagery allows readers to visualise Wonka's eccentric
world, making it a memorable reading experience.

While Roald Dahl's tales are filled with whimsy and fantasy, they are embraced with important
life lessons. Dahl uses his simple prose to convey messages of kindness, resilience and the
triumph of good over evil. In ‘The Witches', Dahl addresses themes of courage and
resourcefulness as a young boy battles a coven of witches. Dahl's straightforward language
carries a powerful message, 'You are using the bravery of a small boy and the intelligence of
a mouse to defeat your enemy. And you are doing it brilliantly'. Dahl's ability to blend simplicity
with profound themes makes his stories not only enjoyable but also impactful.

SubQuestion No : 28

Q.28 Which of the following options best summarises the passage about Roald Dahl's
writing style?

Ans X A.Dahl's books are complex and challenging, meant only for adults.

5 B. Through fantastical settings, Dahl's stories convey complex messages using
advanced vocabulary.

#5 C. Roald Dahl's writing is too childish and lacks depth.

¢ D. Roald Dahl's engaging writing style combines clear and simple language with rich
themes, making his stories enjoyable for-all ages.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCQ
630680805370
6306803155173
6306803155175
6306803155176
6306803155174
Answered

C

-0.25
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Comprehension:
Read the passage carefully and answer the questions that follow.

One of the hallmarks of Roald Dahl's writing style is its simplicity. His prose is clear, concise
and utterly engaging. Dahl masterfully crafts stories that are accessible to readers of all ages
without sacrificing depth or emotional resonance. His choice of words is precise, making it
easy for young readers to grasp the narrative, while still providing a rich reading experience
for adults.

In ‘Matilda’, Dahl introduces us to a brilliant young girl with telekinetic powers. Through Dahl's
straightforward prose, we enter Matilda's world effortlessly. 'It's a funny thing about mothers
and fathers. Even when their own child is the most disgusting little blister you could ever
imagine, they still think that he or she is wonderful', reads one of the endearing quotes in the
book 'Matilda'. Dahl's ability to address complex themes, such as neglect and injustice,
through simple language is a proof of his storytelling intelligence.

In the iconic ‘Charlie and the Chocolate Factory', Dahl invites us into Willy Wonka's candy-
filled wonderland. His descriptions of the factory are brimming with imagination, 'The walls
and ceiling were covered with large patches of something that looked like thick, brown fur
carpet. In the places where there were no patches of fur, there were large splodges of a
revolting greenish mold'. Dahl's vivid imagery allows readers to visualise Wonka's eccentric
world, making it a memorable reading experience.

While Roald Dahl's tales are filled with whimsy and fantasy, they are embraced with important
life lessons. Dahl uses his simple prose to convey messages of kindness, resilience and the
triumph of good over evil. In ‘The Witches', Dahl addresses themes of courage and
resourcefulness as a young boy battles a coven of witches. Dahl's straightforward language
carries a powerful message, 'You are using the bravery of a small boy and the intelligence of
a mouse to defeat your enemy. And you are doing it brilliantly'. Dahl's ability to blend simplicity
with profound themes makes his stories not only enjoyable but also impactful.
SubQuestion No : 29

Q.29 Select the most appropriate title for the passage.

Ans X A. Understanding Complex Themes Through Children's Literature
#5 B. The Importance of Simple Language in Writing

o C. The Magic of Roald Dahl's Stories
& D. ALook at 'Matilda' and 'Charlie and the Chocolate Factory'

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

MCcQ
630680805369
6306803155172
6306803155170
6306803155169
6306803155171
Answered

D

-0.25
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Comprehension:
Read the passage carefully and answer the questions that follow.

One of the hallmarks of Roald Dahl's writing style is its simplicity. His prose is clear, concise
and utterly engaging. Dahl masterfully crafts stories that are accessible to readers of all ages
without sacrificing depth or emotional resonance. His choice of words is precise, making it
easy for young readers to grasp the narrative, while still providing a rich reading experience
for adults.

In ‘Matilda’, Dahl introduces us to a brilliant young girl with telekinetic powers. Through Dahl's
straightforward prose, we enter Matilda's world effortlessly. 'It's a funny thing about mothers
and fathers. Even when their own child is the most disgusting little blister you could ever
imagine, they still think that he or she is wonderful', reads one of the endearing quotes in the
book 'Matilda'. Dahl's ability to address complex themes, such as neglect and injustice,
through simple language is a proof of his storytelling intelligence.

In the iconic ‘Charlie and the Chocolate Factory', Dahl invites us into Willy Wonka's candy-
filled wonderland. His descriptions of the factory are brimming with imagination, 'The walls
and ceiling were covered with large patches of something that looked like thick, brown fur
carpet. In the places where there were no patches of fur, there were large splodges of a
revolting greenish mold'. Dahl's vivid imagery allows readers to visualise Wonka's eccentric
world, making it a memorable reading experience.

While Roald Dahl's tales are filled with whimsy and fantasy, they are embraced with important
life lessons. Dahl uses his simple prose to convey messages of kindness, resilience and the
triumph of good over evil. In ‘The Witches', Dahl addresses themes of courage and
resourcefulness as a young boy battles a coven of witches. Dahl's straightforward language
carries a powerful message, 'You are using the bravery of a small boy and the intelligence of
a mouse to defeat your enemy. And you are doing it brilliantly'. Dahl's ability to blend simplicity
with profound themes makes his stories not only enjoyable but also impactful.

SubQuestion No : 30

Q.30 Select the most appropriate synonym of the word ‘eccentric’ as given in the following
sentence from the given passage.

'Dahl's vivid imagery allows readers to visualise Wonka's eccentric world, making it a
memorable reading experience’'.

Ans X A. Ordinary
#< B. Conventional
o C. Strange
< D. Familiar

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
630680805373
6306803155185
6306803155186
6306803155187
6306803155188
Answered

A

-0.25
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Q.31

Ans

Comprehension:

Read the given passage and answer the questions that follow.

Grapes are one of the most commonly consumed fruits in any Indian household. However, it
is not hidden that grapes are heavily contaminated with pesticides, and consuming such fruits

can lead to various health issues — including potential harm to the nervous system,
disruption of hormone function and an increased risk of cancer.

But what if you can grow these juicy delights easily at home in containers?

Delhi-based urban gardener Rashmi Shukla has been growing grapes on the rooftop of her
house for the last seven years. She says growing grapevines in a grow bag and container is
not very cumbersome and can be done with little care. And as a bonus, your garden will be

frequented by a lot of birds!

According to Rashmi, grapes can be grown through seeds as well as cuttings but gardeners
should opt for a sapling. “It will substantially reduce the time taken for the plant to bear fruits.
If you use seeds, it may take many years before fruiting, while a sapling can fruit in three
years if properly nurtured,” she adds.

SubQuestion No : 31
What potential health issues are associated with consuming pesticide-contaminated

grapes?
#5 A. Allergic reactions and low-grade fever
o’ B. Nervous system harm, hormone disruption and increased cancer risk
& C. Cardiovascular diseases and pulmonary disorders

& D. Respiratory problems and indigestion

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCcQ
630680796695
6306803121759
6306803121757
6306803121758
6306803121756
Answered

B

1
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Comprehension:

Read the given passage and answer the questions that follow.

Grapes are one of the most commonly consumed fruits in any Indian household. However, it
is not hidden that grapes are heavily contaminated with pesticides, and consuming such fruits

can lead to various health issues — including potential harm to the nervous system,
disruption of hormone function and an increased risk of cancer.

But what if you can grow these juicy delights easily at home in containers?

Delhi-based urban gardener Rashmi Shukla has been growing grapes on the rooftop of her
house for the last seven years. She says growing grapevines in a grow bag and container is
not very cumbersome and can be done with little care. And as a bonus, your garden will be

frequented by a lot of birds!

According to Rashmi, grapes can be grown through seeds as well as cuttings but gardeners
should opt for a sapling. “It will substantially reduce the time taken for the plant to bear fruits.
If you use seeds, it may take many years before fruiting, while a sapling can fruit in three
years if properly nurtured,” she adds.

SubQuestion No : 32
Q.32 Which of the following is the most appropriate title for the passage?

Ans X A. The Popularity of Grapes in Indian Households
5 B. The Health Risks of Consuming Grapes

#5 C. The Nutritional Benefits of Grapes

¢ D. Growing Grapes at Home: A Guide by an Urban Gardener

Question Type : MCQ
Question ID : 630680796694
Option 11D : 6306803121753
Option 2 ID : 6306803121752
Option 3 ID : 6306803121755
Option 4 ID : 6306803121754
Status : Answered
Chosen Option : B
Marks : -0.25
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Comprehension:
Read the given passage and answer the questions that follow.

can lead to various health issues — including potential harm to the nervous system,
disruption of hormone function and an increased risk of cancer.

But what if you can grow these juicy delights easily at home in containers?

frequented by a lot of birds!

years if properly nurtured,” she adds.

SubQuestion No : 33
Q.33 What does the word ‘cumbersome’ mean in the passage?

Ans X A. Quick
< B. Fun

& C.Easy
 D. Difficult

Grapes are one of the most commonly consumed fruits in any Indian household. However, it
is not hidden that grapes are heavily contaminated with pesticides, and consuming such fruits

Delhi-based urban gardener Rashmi Shukla has been growing grapes on the rooftop of her
house for the last seven years. She says growing grapevines in a grow bag and container is
not very cumbersome and can be done with little care. And as a bonus, your garden will be

According to Rashmi, grapes can be grown through seeds as well as cuttings but gardeners
should opt for a sapling. “It will substantially reduce the time taken for the plant to bear fruits.
If you use seeds, it may take many years before fruiting, while a sapling can fruit in three

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680796698
6306803121771
6306803121770
6306803121768
6306803121769
Answered

B

-0.25
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Comprehension:
Read the given passage and answer the questions that follow.

can lead to various health issues — including potential harm to the nervous system,
disruption of hormone function and an increased risk of cancer.

But what if you can grow these juicy delights easily at home in containers?

frequented by a lot of birds!

years if properly nurtured,” she adds.

SubQuestion No : 34
Q.34 What can be inferred about growing grapes at home?

Ans X A. It requires a significant amount of effort and expertise.
& B. Itis impossible to grow grapes in urban areas.
¢ C. It can attract birds to your garden.

#5 D. It is more expensive than buying grapes from the market.

Grapes are one of the most commonly consumed fruits in any Indian household. However, it
is not hidden that grapes are heavily contaminated with pesticides, and consuming such fruits

Delhi-based urban gardener Rashmi Shukla has been growing grapes on the rooftop of her
house for the last seven years. She says growing grapevines in a grow bag and container is
not very cumbersome and can be done with little care. And as a bonus, your garden will be

According to Rashmi, grapes can be grown through seeds as well as cuttings but gardeners
should opt for a sapling. “It will substantially reduce the time taken for the plant to bear fruits.
If you use seeds, it may take many years before fruiting, while a sapling can fruit in three

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680796697
6306803121764
6306803121767
6306803121765
6306803121766
Answered

C

1
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Q.35

Ans

Comprehension:

Read the given passage and answer the questions that follow.

Grapes are one of the most commonly consumed fruits in any Indian household. However, it
is not hidden that grapes are heavily contaminated with pesticides, and consuming such fruits

can lead to various health issues — including potential harm to the nervous system,
disruption of hormone function and an increased risk of cancer.

But what if you can grow these juicy delights easily at home in containers?

Delhi-based urban gardener Rashmi Shukla has been growing grapes on the rooftop of her
house for the last seven years. She says growing grapevines in a grow bag and container is
not very cumbersome and can be done with little care. And as a bonus, your garden will be

frequented by a lot of birds!

According to Rashmi, grapes can be grown through seeds as well as cuttings but gardeners
should opt for a sapling. “It will substantially reduce the time taken for the plant to bear fruits.
If you use seeds, it may take many years before fruiting, while a sapling can fruit in three
years if properly nurtured,” she adds.

SubQuestion No : 35

According to Rashmi Shukla, how long does it take for a grapevine sapling to bear
fruit if properly nurtured?

5 A. One year
5 B. Seven years
o C. Three years

& D. Five years

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 1D :

Status :

Chosen Option :

Marks :

MCcQ
630680796696
6306803121760
6306803121763
6306803121761
6306803121762
Answered

B

-0.25
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He had no society, no friend, not even a daily paper to relax.

Ans A
Glwa caléld AAIG G, dIFFeieN GeIml, 9URE |IE JU6RIGE TC163 §eawItk §6a § agmll

X B.
64 dIC@e giér @2JEm, 69 el 6¢IwEh! Sl96inltle difadlom |

< C.
SPQ@ICe U@l Grl6s Gler 16Q AFle QAR & Aieh & Geleml

X D. QIFQ 644 991G, A2 Xl HLARIGS Fem |

Question Type : MCQ
Question ID : 6306801144680
Option 1 1D : 6306804498892
Option 2 ID : 6306804498893
Option 3 ID : 6306804498891
Option 4 ID : 6306804498890
Status : Answered
Chosen Option : A
Marks : 1

Q2 paGyl 861 SIRYES gER 9616 906 TIRiE0 DR66 89 @ - S99Ige § TIa @ - 6FIRRL, 919, 65% 6 6 - G5
AR 418 ¢ - F9Q TGY6 @ P08 KD,

Ans JARGER
KB @oada
XCol@adl
X D. @ ¢l ¢l d

Question Type : MCQ
Question ID : 6306801155264
Option 11D : 6306804540898
Option 2 ID : 6306804540897
Option 3 ID : 6306804540899
Option 4 ID : 6306804540896
Status : Answered
Chosen Option : A
Marks : 1
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Q3 e - -
FIRNFYS R°QIGT FITY BITER 2IGIIT R
On holidays, | prefer to stay at home.
Ans o A gTER6R G6Q 9EFIg ¢ 990 R6Q |
X B. gEGQAIREER ¢ €60 0ERIg 098 R6Q |
X C. gERGAIE@ER €EQ QER! 6719 9 |
X 0. §50a60 ¢ W6a 089G IR R6Q |
Question Type : MCQ
Question ID : 6306801104529
Option 11D : 6306804338651
Option 21D : 6306804338652
Option 3 ID : 6306804338649
Option 4 ID : 6306804338650
Status : Answered
Chosen Option : B
Marks : -0.25
Q4 - -~ — —
FeRge rale! PRty 6ERIeR 21gele Kl
Nobody invites death of his own accord.
Ans X A 6R% 00QIg SI6E Q1F |
X B. ¢JoN QIFIQ 98160 94 @IF |
X C. €94 QILI0 FI9Ea Q2 |
¥ D. 658 G6 99169 704 RER QIF |
Question Type : MCQ
Question ID : 6306801157876
Option 11D : 6306804550641
Option 21D : 6306804550642
Option 3 ID : 6306804550640
Option 4 ID : 6306804550643
Status : Answered
Chosen Option: C
Marks : -0.25
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Question Type :
Question ID :

: 6306804428004
Option 21D :
Option 31D :
Option 4 ID :
Status :

Chosen Option :
Marks :

Option 1 ID

McQ
6306801126952

6306804428003
6306804428005
6306804428002
Answered

B

1

Q6 AR JOd K-
Plowm 9 assl
Ans g A €QIQ
X B. @@
X C e
X 0. Q)

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 1D :

Status :

Chosen Option :

Marks :

MCcQ
6306801124886
6306804419763
6306804419764
6306804419766
6306804419765
Answered

A

1
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Question Type : MCQ
Question ID : 6306801154763
Option 11D : 6306804538969
Option 21D : 6306804538970
Option 3 ID : 6306804538967
Option 4 ID : 6306804538968
Status : Answered
Chosen Option : B
Marks : 1
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Ans X A QLG
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X C. d6QIRIe
¥ D. GEMIGIS

Question Type : MCQ
Question ID : 6306801147070
Option 11D : 6306804508414
Option 2 ID : 6306804508413
Option 3 ID : 6306804508416
Option 4 ID : 6306804508415
Status : Answered
Chosen Option : D
Marks : 1
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Question Type : MCQ
Question ID : 6306801154570
Option 11D : 6306804538205
Option 21D : 6306804538206
Option 3 ID : 6306804538204
Option 4 ID : 6306804538207
Status : Answered
Chosen Option : A
Marks : 1
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Question Type : MCQ
Question ID : 6306801154555
Option 11D : 6306804538145
Option 2 ID : 6306804538144
Option 3 ID : 6306804538143
Option 4 ID : 6306804538162
Status : Answered
Chosen Option : B
Marks : 1
Q11 .. - -
QRGeS p°elw] PRIty Beelica 2Agele @l
She has been staying in Bhubaneswar since her birth.
Ans X A 69 OIF GQQ RLERTR6R QLS |
X B. 69 G G NYEFYRER P19 9985 |
X C. 64 9QQ HERIR5Q F19 @TYLT |
¥ D. 69 G9Q 996RYIER AFFE |
Question Type : MCQ
Question ID : 6306801104720
Option 11D : 6306804339409
Option 2 ID : 6306804339412
Option 31D : 6306804339410
Option 4 ID : 6306804339411
Status : Answered
Chosen Option : A
Marks : -0.25
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Next month, | will have been following a diet for three months.

Question Type

Option 1 ID

:MCQ
Question ID :
: 6306804340001
Option 21D :
Option 31D :
Option 4 ID :
Status :

Chosen Option :
Marks :

6306801104868

6306804340004
6306804340003
6306804340002
Answered

B

-0.25
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Question Type

:MCQ
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 1D :

Status :

Chosen Option :

Marks :

6306801135342
6306804461544
6306804461545
6306804461542
6306804461543
Answered

A

1
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Ans

Q14

FIRGS FUAIGT PNty BERIER 2GR KAl
The teacher asked the students to submit their assignments before 8 in the morning.

<A
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Question Type

Option 3 ID

Question ID :
Option 11D :
Option 2 ID :

Option 4 ID :
Status :

Chosen Option :
Marks :

: MCcQ
6306801104891
6306804340093
6306804340095
: 6306804340094
6306804340096
Answered

C

-0.25

Q.15

Ans

FORFe aralal eIty 6o BIgele @Al
The unlucky people should not hope for greatness.

X A GIENEE ERIXIEE @@ 6291y sl @ 29 |

¢ B Qloliele ERIGles @@ 629l il @09 e QS‘IF |
X C. QLR eniRcIes 68l 62 1 2l RED 6 |

X D. QIGNEIR CRIRFISR G D¢ 6959l 856 g2 |

Option 3 ID

Question Type :
Question ID :
Option 11D :
Option 21D :

McQ

6306801157036
6306804547345
6306804547344

1 6306804547343
Option 41D :
Status :

Chosen Option :
Marks :

6306804547342
Answered

B

1
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16 = - -
@ FEMEe Qe @Ry GLEIER EgeIe @Rl
Modern warfare has little to do with the numerical strength of the soldiers.
Ans A

2lkjea g8 goiel 6364 2PayIa 0Ras a06a Ae9 R6a QIF |
X B 2llae gF Jalla 690Y 2°6l K960 G @6Q |

X C Ziyae gF gaIe 63qY 2°aiIn G096 2962 G99 26 |
X D. 2GR B IR1 6NN 2060 FRa R6Q QI |

Question Type : MCQ
Question ID : 6306801157774
Option 1 ID : 6306804550240
Option 2 ID : 6306804550238
Option 3 1D : 6306804550239
Option 4 ID : 6306804550241
Status : Answered
Chosen Option : C
Marks : -0.25
Q17 - -
AEmYe DRIl L@ty BYElea Egele ¥l
Will you help me with the main areas here so | could travel comfortably?
Ans X A.
q0leR 21 e AIegEe Faaeca cAIse gar videds afaidelg Ry ahe @ sadi ¢ ainines AIgl *RQIBE?
X B.
90I6R g9 g8 AIRGER Taeq 6716e g6rl fIdedn QATIGen ¢ 2IRIFEa QIG RANINE?
& C.
0160 Y@ e BIRgER FHRIED 6rIIee g6l cidada @AaIte & SATt? ¢ AN Qg RRRINE?
X D.
691166 Q61 90162 2RI 3N BingGe Saasa videde ofe & coadd J a1aIre0 Qig @00IRE?
Question Type : MCQ
Question ID : 6306801104943
Option 11D : 6306804340302
Option 2 1D : 6306804340304
Option 3 ID : 6306804340301
Option 4 ID : 6306804340303
Status : Answered
Chosen Option : D
Marks : -0.25
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Marks :

Ans X A g6l
B gQl@lal
& C. gledcallc
X D. gl@dlgl
Question Type : MCQ
Question ID : 6306801125572
Option 1 ID : 6306804422487
Option 2 ID : 6306804422485
Option 3 ID : 6306804422488
Option 4 ID : 6306804422486
Status : Answered
Chosen Option : B
Marks : 1
Q19 .= P = = s
‘T QEQ EMERE Y- EIQ RI9Y JeKeR GEm @6 6897
Ans X A aRgEl 4 988 enge’ |
X B @41+ 9&C cResags?
¢ C QEIF101 9 987 endIgiag |
X D. 4] @u6' & emgas?
Question Type : MCQ
Question ID : 6306801122296
Option 1 1D : 6306804409435
Option 2 ID : 6306804409436
Option 3 ID : 6306804409433
Option 4 ID : 6306804409434
Status : Answered
Chosen Option: C
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4% SaRge srast IeYey BhRIca AgeIe @Al

A mess was made by drunkards during the marriage party.

A X A Q912 6RIGER AINYATISR I8 SR @026R |
X B. §9I2 6QIG 4FIEI60 AIDYEIFIER U@ Sgital 98 aTgjem |
v C GQI2 culGeq AIRYarIer Fesrel @GgeR |
X 0. §9I2 6RITER AIarIew TIQl Beral 98 @T2eR |

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
6306801104813
6306804339731
6306804339783
6306804339784
6306804339782
Answered

B
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Q.21

Ans

Comprehension:

Ageee Bgaiel dé 9eea @aa §2 |

2licl ERIdg 6RLFI6R G2IR @3 21857 2IFa IEN6! 6 YT T86R CRACITE
AeQle QE8 ?

ISR goig das! 464 691R AIF caaad 9e° cialg @ aateada 69IR 2Ief
CARSE, 62CITE Q6T AelG

986 91 gol 986 6aNIES 2TsIg SIT Felia ABRISIE, cadowa | G196Q 699
gelea

AeGwa ATNIS TR, 69T goig IR AAIE 99° FIEEe IeaIg 96T
6Qlm FlIgamI |

@5 26559 629G AIFeR QI | KR 98 @ ARG goIa QY 6d ¢IQ G19RQ
LRI el 92

6gia 999 @4 FIZifen AIF | 2194 @099 99 I FIERIS 6d FIGER QITER
IO & FIRIG

%0 @hiolg AIGeR | 69906 @F 64 28I VPG 696 | ZIKEI KIS6R PEAG
AR 69 6QI6EETER

SIEgE CINeRs @R26R, g19a 698 gl 6 Al JALISR €2656R6w Sl AIRIES
€9ln @E2ER |

@3 Z6eR 2610 ©F 69 216 2IF 26eTdE AYERITIR TR 6RR 691N @gg |

SubQuestion No : 21

609 RIS d6ged 2ITEl 196 SRS ?

X A 2I5ieoe 2wl QiR
¢ B 0o dIndla Saiaa! T

X C. qi5Ioe o Sim
X D. gy&Eicie deiel Sigl

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
6306801155715
6306804542545
6306804542542
6306804542544
6306804542543
Answered

B
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Ans

Comprehension:

Ageee Bgaiel dé 9eea @aa §2 |

2licl ERIdg 6RLFI6R G2IR @3 21857 2IFa IEN6! 6 YT T86R CRACITE
AeQle QE8 ?

ISR goig das! 464 691R AIF caaad 9e° cialg @ aateada 69IR 2Ief
CARSE, 62CITE Q6T AelG

986 91 gol 986 6aNIES 2TsIg SIT Felia ABRISIE, cadowa | G196Q 699
gelea

AeGwa ATNIS TR, 69T goig IR AAIE 99° FIEEe IeaIg 96T
6Qlm FlIgamI |

@5 26559 629G AIFeR QI | KR 98 @ ARG goIa QY 6d ¢IQ G19RQ
LRI el 92

6gia 999 @4 FIZifen AIF | 2194 @099 99 I FIERIS 6d FIGER QITER
IO & FIRIG

%0 @hiolg AIGeR | 69906 @F 64 28I VPG 696 | ZIKEI KIS6R PEAG
AR 69 6QI6EETER

SIEgE CINeRs @R26R, g19a 698 gl 6 Al JALISR €2656R6w Sl AIRIES
€9ln @E2ER |

@3 Z6eR 2610 ©F 69 216 2IF 26eTdE AYERITIR TR 6RR 691N @gg |

SubQuestion No : 22
A2 gaq 20 agene 57168 298 I8 ?

X A el 491 Y016 Cisl 299 |

X B Q@8 Se) d0Ie Fw1E divl 299% |

X ¢ Qeg d696! dfls aI4 Cip AGa |

v 0. QIOAGIRG! 26Tl geRel 2918 SRId Tivl ZgeW |

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
6306801155718
6306804542557
6306804542556
6306804542554
6306804542555
Answered
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Q.23

Ans

Comprehension:
Ageee Bgaiel dé 9eea @aa §2 |

2licl ERIdg 6RLFI6R G2IR @3 21857 2IFa IEN6! 6 YT T86R CRACITE
AeQle QE8 ?

ISR goig das! 464 691R AIF caaad 9e° cialg @ aateada 69IR 2Ief
CARSE, 62CITE Q6T AelG

986 91 gol 986 6aNIES 2TsIg SIT Felia ABRISIE, cadowa | G196Q 699
gelea

AeGwa ATNIS TR, 69T goig IR AAIE 99° FIEEe IeaIg 96T
6Qlm FlIgamI |

@5 26559 629G AIFeR QI | KR 98 @ ARG goIa QY 6d ¢IQ G19RQ
LRI el 92

6gia 999 @4 FIZifen AIF | 2194 @099 99 I FIERIS 6d FIGER QITER
IO & FIRIG

%0 @hiolg AIGeR | 69906 @F 64 28I VPG 696 | ZIKEI KIS6R PEAG
AR 69 6QI6EETER

SIEgE CINeRs @R26R, g19a 698 gl 6 Al JALISR €2656R6w Sl AIRIES
€9ln @E2ER |

@3 Z6eR 2610 ©F 69 216 2IF 26eTdE AYERITIR TR 6RR 691N @gg |

SubQuestion No : 23
SERGE Ul FRID 6aRE gel IGeas i AGYE AT ?
X A goae 19910 2gAad
v B 209 98a
X C. @yyedla Bediea!
X D. & 49910 2623

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
6306801155714
6306804542538
6306804542540
6306804542539
6306804542541
Answered

B

1

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1/0SSC241/0SSC241S9D1351/17297514871767219/230738904... 33/75

3@ Teachingninja.in



10/28/24, 7:03 PM

cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1/0SSC241/0SSC241S9D1351/17297514871767219/...

Q.24

Ans

Comprehension:
Ageee Bgaiel dé 9eea @aa §2 |

2licl ERIdg 6RLFI6R G2IR @3 21857 2IFa IEN6! 6 YT T86R CRACITE
AeQle QE8 ?

ISR goig das! 464 691R AIF caaad 9e° cialg @ aateada 69IR 2Ief
CARSE, 62CITE Q6T AelG

986 91 gol 986 6aNIES 2TsIg SIT Felia ABRISIE, cadowa | G196Q 699
gelea

AeGwa ATNIS TR, 69T goig IR AAIE 99° FIEEe IeaIg 96T
6Qlm FlIgamI |

@5 26559 629G AIFeR QI | KR 98 @ ARG goIa QY 6d ¢IQ G19RQ
LRI el 92

6gia 999 @4 FIZifen AIF | 2194 @099 99 I FIERIS 6d FIGER QITER
IO & FIRIG

%0 @hiolg AIGeR | 69906 @F 64 28I VPG 696 | ZIKEI KIS6R PEAG
AR 69 6QI6EETER

SIEgE CINeRs @R26R, g19a 698 gl 6 Al JALISR €2656R6w Sl AIRIES
€9ln @E2ER |

@3 Z6eR 2610 ©F 69 216 2IF 26eTdE AYERITIR TR 6RR 691N @gg |

SubQuestion No : 24
Q6509 7 AEITIA FOI00 6RR 691 FITR GG ?
VA B4 9OF 4 G T80 JoRe @56 |
X B 64 g1@ @910 JOIFe @G2Em |
X c. 64 GoR dIgeY 0okl @06 |
X D. 64 €FRIGR 299I9Q K026R

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCcQ
6306801155716
6306804542546
6306804542549
6306804542547
6306804542548
Answered

A
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Ans

Comprehension:

Ageee Bgaiel dé 9eea @aa §2 |

2licl ERIdg 6RLFI6R G2IR @3 21857 2IFa IEN6! 6 YT T86R CRACITE
AeQle QE8 ?

ISR goig das! 464 691R AIF caaad 9e° cialg @ aateada 69IR 2Ief
CARSE, 62CITE Q6T AelG

986 91 gol 986 6aNIES 2TsIg SIT Felia ABRISIE, cadowa | G196Q 699
gelea

AeGwa ATNIS TR, 69T goig IR AAIE 99° FIEEe IeaIg 96T
6Qlm FlIgamI |

@5 26559 629G AIFeR QI | KR 98 @ ARG goIa QY 6d ¢IQ G19RQ
LRI el 92

6gia 999 @4 FIZifen AIF | 2194 @099 99 I FIERIS 6d FIGER QITER
IO & FIRIG

%0 @hiolg AIGeR | 69906 @F 64 28I VPG 696 | ZIKEI KIS6R PEAG
AR 69 6QI6EETER

SIEgE CINeRs @R26R, g19a 698 gl 6 Al JALISR €2656R6w Sl AIRIES
€9ln @E2ER |

@3 Z6eR 2610 ©F 69 216 2IF 26eTdE AYERITIR TR 6RR 691N @gg |

SubQuestion No : 25
% 29600 6aR60 679 98 6RI6E go% AR K0S 7

KA QIGERER

v B QIite
X C glelitia
X D. eGRIGE

Question Type :

Question ID :

Option 11D :

Option 21D :

Option 31D :

Option 41D :

Status :

Chosen Option :

Marks :

McQ
6306801155717
6306804542553
6306804542552
6306804542551
6306804542550
Answered

B
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Comprehension:
Geuslen! G¢ AYe 2geaaty Ue JERIER Teg B 93 I9° GI06R
F2LRP 949 0@ 29 fea 203 |
A9 9@ P65 JIENSCeEa fal 2ge daY @ 2°e6 00nEe ceimald | 840,
20 @ A1 62905 YTIQ g% RQILRE | AYIRIgEe Ias cein §IC AYRaR
JEAROT | CANRT CRT ZFFE F6M 6AFIEE LUTT NIET BFFIERINNG AAULE 8
Faq 9086 @08 | 9RAIER a6l 9R6a Falt faIe @gle 0l @08 | Sgeaies
BRI TS FINY QEIRIg C1TERLYIR Go 6T 61T ERIRy NSy @RF |
ZIREIHER R12Q2R! 291, 71X, FJ6., S8R RSUT IS AGEY 9F ACITS F6TER T’
PA® 2AGE | 6AIER 6412 190 AINR K08 | FRSNIE AWINER GRIAN, ‘TIRd Tt rol,
geEal 69ag CSI6T, 220 FINErIEE Jaa J2@ SIS 9QI6M Fkl FUQ A7 A°UeE
@IPEQ Ggg IPIERI 90F | 6AIEE K2E, Fd JRER FId 9dlg ALY REQRIT |
AYFIRE S@ IVIFIRE FRICS Y& IRCIa 21I0d F0R 6T | 6aIER Fkl PUIR 69RYSIR
Ie° ZIQISIER QAT QINED EREITIE | AIRISAICER TSICIER 6541eE WUPER T9R Q1T
110G QU910 4l 2164 QLG 26T | QI 9EeRCIIET GIREIg, AG8I OIF 9@tea @4l
QIB IR 19 A0F | 69FIER g8 QR Q16T JYENLER OF SIGY A°PL QA0 9e°
ALNFY ol AIREA UEJE Q6T VPR 2IFYE 99T | REUIGFIER TR Glee YiFIal §al
QRS FIRG UA 2RI AIdEn TRINE @RI IR gRa IR 980 6RIT | AIRcIeR
FeIe geIR BI6 SIRY ZIEYVS @RISR Tl a@ AFN6R FJFeW F1RIR YRg (2R QI-al
R0 05ea Jafic ARl 2IAKINEa IeiE 2gPEe Far 266 | RIgadier 99 draea
ATSF QP60 PRSISIER 2gel F2E | IMIFTR FE6 @RYe FgeNg @6 ZIeR S9eIE |

SubQuestion No : 26

9% 20063 2GEEDa 8 FHASY @417
A x A Qg 9ERBFIEE YRE GIFER @4l 918 919 KOF |

X B. @@flEE GG 10l @0I6 $RI¢ @lP Q96! @9F |
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ZIRISFIGER aRiFIeR IRIes KR 99F FIF 1ee KGaIE |

v D. digNeQecs @l |

Option 3 ID

Question Type :
Question ID :
Option 11D :
Option 21D :

1 6306804507679

Option 4 ID :
Status :

Chosen Option :
Marks :

McQ

6306801146886
6306804507678
6306804507676

6306804507677
Answered

D
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Comprehension:
Geuslen! G¢ AYe 2geaaty Ue JERIER Teg B 93 I9° GI06R
F2LRP 949 0@ 29 fea 203 |
A9 9@ P65 JIENSCeEa fal 2ge daY @ 2°e6 00nEe ceimald | 840,
20 @ A1 62905 YTIQ g% RQILRE | AYIRIgEe Ias cein §IC AYRaR
JEAROT | CANRT CRT ZFFE F6M 6AFIEE LUTT NIET BFFIERINNG AAULE 8
Faq 9086 @08 | 9RAIER a6l 9R6a Falt faIe @gle 0l @08 | Sgeaies
BRI TS FINY QEIRIg C1TERLYIR Go 6T 61T ERIRy NSy @RF |
ZIREIHER R12Q2R! 291, 71X, FJ6., S8R RSUT IS AGEY 9F ACITS F6TER T’
PA® 2AGE | 6AIER 6412 190 AINR K08 | FRSNIE AWINER GRIAN, ‘TIRd Tt rol,
geEal 69ag CSI6T, 220 FINErIEE Jaa J2@ SIS 9QI6M Fkl FUQ A7 A°UeE
@IPEQ Ggg IPIERI 90F | 6AIEE K2E, Fd JRER FId 9dlg ALY REQRIT |
AYFIRE S@ IVIFIRE FRICS Y& IRCIa 21I0d F0R 6T | 6aIER Fkl PUIR 69RYSIR
Ie° ZIQISIER QAT QINED EREITIE | AIRISAICER TSICIER 6541eE WUPER T9R Q1T
110G QU910 4l 2164 QLG 26T | QI 9EeRCIIET GIREIg, AG8I OIF 9@tea @4l
QIB IR 19 A0F | 69FIER g8 QR Q16T JYENLER OF SIGY A°PL QA0 9e°
ALNFY ol AIREA UEJE Q6T VPR 2IFYE 99T | REUIGFIER TR Glee YiFIal §al
QRS FIRG UA 2RI AIdEn TRINE @RI IR gRa IR 980 6RIT | AIRcIeR
FeIe geIR BI6 SIRY ZIEYVS @RISR Tl a@ AFN6R FJFeW F1RIR YRg (2R QI-al
R0 05ea Jafic ARl 2IAKINEa IeiE 2gPEe Far 266 | RIgadier 99 draea
ATSF QP60 PRSISIER 2gel F2E | IMIFTR FE6 @RYe FgeNg @6 ZIeR S9eIE |

SubQuestion No : 27

G 98 TIgees din 90Ye HIHe 91T |

Ans

X A AFIEeG

X B. CI9® R19Q
¢ C. @910 SE
X p. ggllel g9

Status

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

: Answered

Chosen Option :

Marks :

McQ

6306801146884
6306804507668
6306804507669
6306804507670
6306804507671
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Comprehension:
Geuslen! G¢ AYe 2geaaty Ue JERIER Teg B 93 I9° GI06R
F2LRP 949 0@ 29 fea 203 |
A9 9@ P65 JIENSCeEa fal 2ge daY @ 2°e6 00nEe ceimald | 840,
20 @ A1 62905 YTIQ g% RQILRE | AYIRIgEe Ias cein §IC AYRaR
JEAROT | CANRT CRT ZFFE F6M 6AFIEE LUTT NIET BFFIERINNG AAULE 8
Faq 9086 @08 | 9RAIER a6l 9R6a Falt faIe @gle 0l @08 | Sgeaies
BRI TS FINY QEIRIg C1TERLYIR Go 6T 61T ERIRy NSy @RF |
ZIREIHER R12Q2R! 291, 71X, FJ6., S8R RSUT IS AGEY 9F ACITS F6TER T’
PA® 2AGE | 6AIER 6412 190 AINR K08 | FRSNIE AWINER GRIAN, ‘TIRd Tt rol,
geEal 69ag CSI6T, 220 FINErIEE Jaa J2@ SIS 9QI6M Fkl FUQ A7 A°UeE
@IPEQ Ggg IPIERI 90F | 6AIEE K2E, Fd JRER FId 9dlg ALY REQRIT |
AYFIRE S@ IVIFIRE FRICS Y& IRCIa 21I0d F0R 6T | 6aIER Fkl PUIR 69RYSIR
Ie° ZIQISIER QAT QINED EREITIE | AIRISAICER TSICIER 6541eE WUPER T9R Q1T
110G QU910 4l 2164 QLG 26T | QI 9EeRCIIET GIREIg, AG8I OIF 9@tea @4l
QIB IR 19 A0F | 69FIER g8 QR Q16T JYENLER OF SIGY A°PL QA0 9e°
ALNFY ol AIREA UEJE Q6T VPR 2IFYE 99T | REUIGFIER TR Glee YiFIal §al
QRS FIRG UA 2RI AIdEn TRINE @RI IR gRa IR 980 6RIT | AIRcIeR
FeIe geIR BI6 SIRY ZIEYVS @RISR Tl a@ AFN6R FJFeW F1RIR YRg (2R QI-al
R0 05ea Jafic ARl 2IAKINEa IeiE 2gPEe Far 266 | RIgadier 99 draea
ATSF QP60 PRSISIER 2gel F2E | IMIFTR FE6 @RYe FgeNg @6 ZIeR S9eIE |
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Q.1 How much of charge will flow through a circuit carrying direct current of one milli-
ampere in one hour?

Ans X A.0.36 coulomb
#< B. 360 coulomb
¢ C. 3.6 coulomb
#< D. 3600 coulomb

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 1D :

Status :

Chosen Option :

Marks :

McQ
630680517122
6306802020887
6306802020885
6306802020886
6306802020884
Answered

B

-0.25

Q.2 Innovations for Defence Excellence (iDEX), a flagship initiative of the Ministry of
Defence, signed its 250" contract under which of the following?

Ans ¢ A Mission DefSpace
5 B. Mission Khanja
&5 C. Mission Tapas
&5 D. Mission MetaMorph

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680629933
6306802465647
6306802465650
6306802465649
6306802465648
Answered

C

-0.25

Q.3 Which of the following proteins acts as a glue that holds sister chromatids together
until they separate at anaphase?

Ans X A. Cyclin-E1
o B. Cohesin
& C. Geminin
#< D. Securin

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
630680711286
6306802786804
6306802786802
6306802786803
6306802786801
Answered

B

1
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Ans

Q.4 Which physicist is credited with proposing the wave nature of matter?

5 A. Niels Bohr
#< B. Max Planck
& C. Werner Heisenberg

o D. Louis de Broglie

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680774549
6306803036075
6306803036078
6306803036076
6306803036077
Answered

C

-0.25

Ans

space as a tourist?
#< A. Narendra Sharma

< B. Aarohi Pandit
¢ C. Gopichand Thotakura
#5 D. Ayesha Aziz

Q.5 Who among the following people is the first Indian to embark on a journey into the

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 1D :

Status :

Chosen Option :

Marks :

McQ
630680750549
6306802941635
6306802941636
6306802941634
6306802941637
Answered

B

-0.25

Ans

o” A. Stomata
5 B. Pith

#< C. Vacuole
X D. Sieve tube

Q.6 Which of these are tiny pores in plants that regulate the passage of oxygen, carbon
dioxide and water vapour into and out of cells?

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCQ
630680750800
6306802942626
6306802942629
6306802942627
6306802942628
Answered

C

-0.25
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Q.7 India’'s first 5.5-generation stealth fighter, the AMCA, is being developed by which
organisation, and what are they currently seeking?

Ans X A.BEL; suppliers of advanced materials
# B. ISRO; international buyers
¢ C. DRDO; development and production partners

# D. HAL; foreign technical assistance

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
6306801065029
6306804182398
6306804182397
6306804182400
6306804182399
Answered

c

1

Q.8 The Brewster’s law formula is defined as (ig : Brewster’s angle of incidence):
Ans A Tan” (ig)

#X B.Tanig = cos ig /sin ig

¢ C.Tanig =sinig/cosig

# D.Tan™ (i) = sinin / cos i
B B B

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 1D :

Status :

Chosen Option :

Marks :

McQ
630680303270
6306801179737
6306801179734
6306801179735
6306801179736
Answered

B

-0.25

for:

Ans ¢ A asexual reproduction
#5 B. photo respiration
#X C. sexual reproduction

#X D. photosynthesis

Q.9 Rhizome and stolon are examples of modified stem, both of which are used by plants

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
630680668952
6306802619313
6306802619315
6306802619316
6306802619314
Answered

B

-0.25
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Q.10 The Indian Air Force achieved a milestone by successfully test-firing an air-launched
ballistic missile, ROCKS or Crystal Maze 2, capable of hitting targets over
kilometres away. The test, conducted from a Su-30 MKI fighter jet in

demonstrates India's commitment to enhancing defense

capabilities.
Ans X A.200; Rajasthan

&< B. 300; the Kadmat Island
¢ C. 250; the Andaman and Nicobar Islands
#5 D. 150; the Lakshadweep Island

Question Type : MCQ
Question ID : 6306801047636
Option 11D : 6306804112609
Option 2 ID : 6306804112612
Option 3 1D : 6306804112611
Option 4 ID : 6306804112610
Status : Answered
Chosen Option : C
Marks : 1

Section : Current Events

Q.11 What is the name of the candidate who has won a seat for Bharatiya Janta Party (BJP),
in Kerala, for the first time in the General Elections 20247

Ans X A. MV Jayakaran
¢ B. Suresh Gopi
< C.V Vaseef
# D. MK Raghvan

Question Type : MCQ
Question ID : 6306801050031
Option 11D : 6306804122474
Option 2 ID : 6306804122473
Option 3 ID : 6306804122475
Option 4 ID : 6306804122476
Status : Answered
Chosen Option : B
Marks : 1
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Q.12 In which city of India and on which date will 'The Venture Capital World Summit' be
held?

Ans 7 A Mumbai, 215 October 2024
# B. Hyderabad, 10" December 2024
X C. Delhi, 25" November 2024
X D. Bengaluru, 151" September 2024

Question Type : MCQ
Question ID : 6306801057049
Option 11D : 6306804150630
Option 21D : 6306804150632
Option 3 ID : 6306804150631
Option 4 ID : 6306804150629
Status : Answered
Chosen Option : B
Marks : -0.25

Q.13 Which nation introduced the first-ever 100% biodegradable pen to the world in 2024?
Ans X A. Germany

5 B. Japan
# C. China
« D. India

Question Type : MCQ
Question ID : 6306801062078
Option 11D : 6306804170696
Option 21D : 6306804170695
Option 3 ID : 6306804170694
Option 4 ID : 6306804170693
Status : Answered
Chosen Option : D
Marks : 1

Q.14 Who made history as the first Indian gymnast to claim a gold medal at the 2024 Asian
Gymnastics Championships?

Ans X A.Ashish Kumar
¢ B. Dipa Karmakar
# C. Sham Lal

# D. Pranati Nayak

Question Type : MCQ
Question ID : 6306801062341
Option 11D : 6306804171751
Option 21D : 6306804171749
Option 3 ID : 6306804171752
Option 4 ID : 6306804171750
Status : Answered
Chosen Option : B
Marks : 1
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Q.15 Germany became the member of the United Nations Command (UNC) in 2024.
Ans  p A 18t
x B.17th
X c. 15t
X D. 16
Question Type : MCQ
Question ID : 6306801057003
Option 11D : 6306804150440
Option 2 1D : 6306804150439
Option 3 ID : 6306804150437
Option 4 ID : 6306804150438
Status : Answered
Chosen Option : B
Marks : -0.25
Q.16 According to Budget 2024-25, what is the new corporate tax rate for foreign companies
which was 40% earlier?
Ans 7 A 35%
< B.33.55%
&K C.31%
& D.32%
Question Type : MCQ
Question ID : 6306801050109
Option 11D : 6306804122781
Option 2 1D : 6306804122783
Option 3 ID : 6306804122784
Option 4 ID : 6306804122782
Status : Answered
Chosen Option : B
Marks : -0.25
Q.17 HS Prannoy won which of the following medals at BWF World Badminton
Championships 20237
Ans X A.No Medals
# B. Gold
” C. Bronze
#< D. Silver
Question Type : MCQ
Question ID : 630680840792
Option 11D : 6306803293817
Option 2 1D : 6306803293814
Option 3 ID : 6306803293816
Option 4 ID : 6306803293815
Status : Answered
Chosen Option : C
Marks : 1
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Q.18 Which nation introduced the '"Minuteman III', an intercontinental ballistic missile, in
20247

Ans X A.France
5 B.Japan
« C.The US
< D. Russia

Question Type : MCQ
Question ID : 6306801062199
Option 11D : 6306804171186
Option 21D : 6306804171187
Option 3 1D : 6306804171185
Option 4 ID : 6306804171188
Status : Answered
Chosen Option : C
Marks : 1

Q.19 Who was awarded Dhyan Chand Award for Lifetime Achievement in Sports and Games
2023 for the sport of badminton?

Ans X A Kavitha Selvaraj
” B. Manjusha Kanwar
#< C. Sunil Kumar
#< D. Bhaskaran E

Question Type : MCQ
Question ID : 6306801050015
Option 1 1D : 6306804122409
Option 2 ID : 6306804122411
Option 3 ID : 6306804122412
Option 4 ID : 6306804122410
Status : Answered
Chosen Option : B
Marks : 1

Q.20 Which international organisation collaborated with the Ministry of Ayush, Government
of India, in the signing of the Donor Agreement in 2024?

Ans X A. World Trade Organization (WTO)
&5 B. United Nations International Children's Emergency Fund (UNICEF)
4 C. World Health Organization (WHO)
#5 D. United Nations Educational, Scientific and Cultural Organization (UNESCO)

Question Type : MCQ
Question ID : 6306801057012
Option 11D : 6306804150476
Option 2 ID : 6306804150475
Option 3 ID : 6306804150474
Option 4 ID : 6306804150473
Status : Answered
Chosen Option: C
Marks : 1

Section : History of India

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//0SSC241/0SSC241S9D1351/17297514871767219/230738904... 52/75

?@ Teachingninja.in



10/28/24, 7:03 PM

cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//0SSC241/0SSC241S9D1351/17297514871767219/...

Ans

library?
&’ A. Humayun

/< B. Sher Shah

Q.21 Who among the following Mughal emperors died while climbing down the stairs of his

#< C. Akbar
#< D. Babar
Question Type : MCQ
Question ID : 630680766058
Option 11D : 6306803002671
Option 21D : 6306803002668
Option 3 ID : 6306803002670
Option 4 ID : 6306803002669
Status : Answered
Chosen Option : B
Marks : -0.25
Q.22 Who among the following Governor-Generals followed the policy of non-interference
into the affairs of Indian states?
Ans X A. Lord Dufferin
#< B. Lord Dalhousie
#< C. Lord Lytton
¢” D. Lord William Bentinck
Question Type : MCQ
Question ID : 630680595490
Option 11D : 6306802330148
Option 21D : 6306802330149
Option 3 1D : 6306802330151
Option 4 ID : 6306802330150
Status : Answered
Chosen Option : B
Marks : -0.25
Q.23 The Moplah uprising took place in which of the States of India?
Ans X A Gujarat
#< B. Orissa
4 C. Kerala
#< D. Tamil Nadu
Question Type : MCQ
Question ID : 630680577963
Option 11D : 6306802260710
Option 21D : 6306802260713
Option 3 ID : 6306802260712
Option 4 ID : 6306802260711
Status : Answered
Chosen Option : A
Marks : -0.25

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//0SSC241/0SSC241S9D1351/17297514871767219/230738904...

53/75

?@ Teachingninja.in



10/28/24, 7:03 PM cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//0SSC241/0SSC24189D1351/17297514871767219/...

Q.24 Where did the Greeks set up their kingdom during the Maurya dynasty, subsequently
invading India?

Ans X A. Transoxiana
¢ B. Bactria
# C. Babylonia
# D. Sogdiana

Question Type : MCQ
Question ID : 630680571249
Option 11D : 6306802234034
Option 21D : 6306802234035
Option 3 ID : 6306802234033
Option 4 ID : 6306802234036
Status : Answered
Chosen Option : C
Marks : -0.25

Q.25 The Zend-Avesta is the main book of the followers of which religion?
Ans X A. Jainism

#5 B. Judaism
o C. Parsi religion
&5 D. Christianity

Question Type : MCQ
Question ID : 630680650160
Option 11D : 6306802545644
Option 2 ID : 6306802545646
Option 3 ID : 6306802545645
Option 4 ID : 6306802545647
Status : Answered
Chosen Option : B
Marks : -0.25

Q.26 Who among the following was deputed to attend the First Round Table Conference in
November 1930 in London by the Government of Bihar and Orissa?

Ans X A. Hariharrao Raghunathrao
< B. Bhalchandrarao Chintamanrao
4 C. Krushna Chandra Gajapati
# D. Dayanidhi Dharua

Question Type : MCQ
Question ID : 6306801135821
Option 11D : 6306804463414
Option 2 ID : 6306804463415
Option 3 ID : 6306804463416
Option 4 ID : 6306804463417
Status : Answered
Chosen Option : B
Marks : -0.25
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Q.27 Who among the following was the first Indian member of the Viceroy's Executive
Council?

Ans X A.RC Dutt
 B. SP Sinha
# C. Dadabhai Naoroji
X D. GK Gokhale

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680483935
6306801890105
6306801890103
6306801890102
6306801890104
Answered

c

-0.25

Q.28 Whom had Gandhi named as Mira Behn?
Ans  # A Madeleine Slade

5 B. Annie Besant
5 C. Kamla Devi
& D. Indira Gandhi

Question Type

: MCcQ
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

630680607676
6306802377812
6306802377809
6306802377810
6306802377811
Answered

B

-0.25

Q.29 Which of the following cities served as the capital of the Pandya kingdom?
Ans X A. Cholaipattinam

# B. Thanjavur
# C. Kanchipuram
o’ D. Madurai

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCcQ
630680766048
6306803002627
6306803002625
6306803002626
6306803002624
Answered

C

-0.25
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Q.30 The Paramhans Mandali was founded in

to work for the abolition of caste.

Ans X A. Nagpur
< B. Nanded
#< C. Nasik
” D. Bombay
Question Type : MCQ
Question ID : 630680595732
Option 11D : 6306802331116
Option 2 ID : 6306802331119
Option 3 ID : 6306802331117
Option 4 ID : 6306802331118
Status : Answered
Chosen Option: C
Marks : -0.25
Section : Geography
Q.31 Which two states in the North-Western Region have rich sources of salt?
Ans X A. Rajasthan and Haryana
o B. Rajasthan and Gujarat
& C. Gujarat and Madhya Pradesh
#€ D. Punjab and Gujarat
Question Type : MCQ
Question ID : 630680662896
Option 1 1D : 6306802595250
Option 2 ID : 6306802595248
Option 3 ID : 6306802595249
Option 4 ID : 6306802595251
Status : Answered
Chosen Option : C
Marks : -0.25
Q.32 Which of the following river islands, formed as a cluster of many small islands, claims
the title of being the largest river island in India?
Ans ¢ A. Majuli Island
#< B. Andaman Island
#< C. Shivaiji Island
< D. Sunderbans Island
Question Type : MCQ
Question ID : 630680662869
Option 11D : 6306802595138
Option 2 1D : 6306802595139
Option 3 ID : 6306802595136
Option 4 ID : 6306802595137
Status : Answered
Chosen Option : B
Marks : -0.25
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Q.33 Which of the following regions is one of Earth’s last refuges for jaguars, harpy eagles,
and pink river dolphins, and is home to sloths, black spider monkeys, and poison dart
frogs?

Ans X A. South African Safari

&5 B. Arctic
#< C. Nile river
” D. Amazon
Question Type : MCQ
Question ID : 6306801064196
Option 11D : 6306804179123
Option 2 ID : 6306804179125
Option 3 ID : 6306804179126
Option 4 ID : 6306804179124
Status : Answered
Chosen Option : C
Marks : -0.25
Q.34 Which of the following river valleys is NOT known for coal reserves in India?
Ans X A.Damodar
< B. Mahanadi
¢ C. Yamuna
# D. Godavari
Question Type : MCQ
Question ID : 630680652001
Option 1 ID : 6306802552530
Option 2 ID : 6306802552532
Option 3 ID : 6306802552533
Option 4 ID : 6306802552531
Status : Answered
Chosen Option: C
Marks : 1
Q.35 Through which of the following states does the Shetruniji (Shetrunji) river flow?
Ans X A.Jharkhand
#< B. Tamil Nadu
#5 C. Rajasthan
& D. Gujarat
Question Type : MCQ
Question ID : 63068087508
Option 1 ID : 630680339420
Option 2 ID : 630680339419
Option 3 ID : 630680339417
Option 4 ID : 630680339418
Status : Answered
Chosen Option: C
Marks : -0.25
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Q.36 If the government wants to improve the access to electricity in rural areas of India,
which of the following energy sources should they prioritise for the decentralised
power generation?

Ans X A.Petroleum
< B. Coal
o C. Solar
#5 D. Natural gas

Question Type : MCQ
Question ID : 630680874776
Option 11D : 6306803426012
Option 2 1D : 6306803426009
Option 3 ID : 6306803426011
Option 4 ID : 6306803426010
Status : Answered
Chosen Option: C
Marks : 1

Q.37 The desert present between the western central Andes and the Pacific Coast is

Ans X A. Gobi Desert
¢’ B. Atacama Desert
&< C.Thar Desert
#5 D. Sahara Desert

Question Type : MCQ
Question ID : 6306801077553
Option 11D : 6306804232213
Option 2 ID : 6306804232210
Option 3 ID : 6306804232212
Option 4 ID : 6306804232211
Status : Answered
Chosen Option : D
Marks : -0.25

Q.38 'Dun’is a typical feature of:
Ans X A.Assam Himalaya

#< B. Arunachal Himalaya
¢’ C. Uttaranchal Himalaya
#5 D. Sikkim Himalaya

Question Type : MCQ
Question ID : 630680655654
Option 11D : 6306802566589
Option 2 ID : 6306802566588
Option 3 ID : 6306802566586
Option 4 ID : 6306802566587
Status : Answered
Chosen Option : B
Marks : -0.25
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Q.39 The Sardar Sarovar Dam is constructed on which river?

Ans X A. Satlyj
< B. Kaveri
#< C. Periyar
” D. Narmada
Question Type : MCQ
Question ID : 630680652056
Option 11D : 6306802552747
Option 2 ID : 6306802552748
Option 3 ID : 6306802552749
Option 4 ID : 6306802552746
Status : Answered
Chosen Option : D
Marks : 1
Q.40 What is the texture of the alluvial soils found in the piedmont plains of Terai?
Ans X A. Loamy
# B. Clayey
#< C. Fine to medium
o D. Coarse
Question Type : MCQ
Question ID : 63068087945
Option 11D : 630680341167
Option 21D : 630680341168
Option 3 ID : 630680341166
Option 4 ID : 630680341165
Status : Answered
Chosen Option: C
Marks : -0.25
Section : Indian polity an
Q.41 Despite the Supreme Court's ruling on Part IX-B, which provisions related to
cooperative societies remain valid?
Ans X A. Provisions related to single-state cooperative societies
5 B. Provisions related to private cooperative societies
¢ C. Provisions related to multi-state cooperative societies
# D. Provisions related to foreign cooperative societies
Question Type : MCQ
Question ID : 6306801044828
Option 11D : 6306804101464
Option 21D : 6306804101465
Option 3 ID : 6306804101466
Option 4 ID : 6306804101467
Status : Answered
Chosen Option : B
Marks : -0.25

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//0SSC241/0SSC241S9D1351/17297514871767219/230738904...

59/75

?@ Teachingninja.in



10/28/24, 7:03 PM cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//0SSC241/0SSC241S9D1351/17297514871767219/...

Q.42 How many commercial courts are functioning in Odisha as of September 2024?

Ans X A6
X B.4
K C.5
" D.3
Question Type : MCQ
Question ID : 6306801126268
Option 11D : 6306804425289
Option 2 ID : 6306804425287
Option 3 ID : 6306804425288
Option 4 ID : 6306804425286
Status : Answered
Chosen Option : D
Marks : 1
Q.43 In which part of the Constitution of India are the Fundamental Rights included?
Ans 7 A Partlll
& B.Part |V
< C. PartIX
&K D.PartV
Question Type : MCQ
Question ID : 630680733130
Option 11D : 6306802873313
Option 2 1D : 6306802873314
Option 3 ID : 6306802873316
Option 4 ID : 6306802873315
Status : Answered
Chosen Option : A
Marks : 1
Q.44 The first unit of the NTPC Talcher Kaniha plant, located in the Angul district of Odisha,
was commissioned in which year with a capacity of 500 MW?
Ans X A. 2005
& B. 1990
#< C. 2000
o” D. 1995
Question Type : MCQ
Question ID : 6306801146926
Option 11D : 6306804507831
Option 2 ID : 6306804507828
Option 3 ID : 6306804507830
Option 4 ID : 6306804507829
Status : Answered
Chosen Option : B
Marks : -0.25
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Q.45 Under which of the following conditions can Indian citizenship NOT be acquired by
registration?

Ans X A.The person is of Indian origin living in any country.
#5 B. They are minor children of persons who are Indian citizens.
& C. The person is a foreign diplomat stationed in India.

# D. The person is married to an Indian citizen and resides in India.

Question Type : MCQ
Question ID : 630680783857
Option 11D : 6306803071795
Option 21D : 6306803071797
Option 3 ID : 6306803071798
Option 4 ID : 6306803071796
Status : Answered
Chosen Option : B
Marks : -0.25

Q.46 In air pollution, the concepts of PM 2.5 and PM 10 are often used. What does PM stand
for?

Ans X A. Particular matter
¢ B. Particulate matter
#< C. Particulate material

< D. Particulate micron

Question Type : MCQ
Question ID : 630680302493
Option 11D : 6306801176642
Option 21D : 6306801176644
Option 31D : 6306801176643
Option 4 ID : 6306801176645
Status : Answered
Chosen Option: C
Marks : -0.25

Q.47 What is the term used for the power of the President to withhold his assent to a bill?
Ans X A. Dissolution

#5 B. Adjournment
” C. Veto

# D. Prorogation

Question Type : MCQ
Question ID : 630680810227
Option 11D : 6306803174442
Option 21D : 6306803174441
Option 3 ID : 6306803174439
Option 4 ID : 6306803174440
Status : Answered
Chosen Option : C
Marks : 1
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Ans ¢ A. Reduced consumer spending
#5 B. Higher inflation
# C. Increased government debt

# D. Excessive government borrowing

Q.48 Which of the following is a potential drawback of contractionary fiscal policy during an
economic downturn?

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :
Chosen Option :

Marks :

McQ
630680774233
6306803034839
6306803034837
6306803034838
6306803034840
Answered

c

-0.25

Q.49 In the calculation of the Human Development Index (HDI), why is gross domestic
product (GDP) per capita adjusted for purchasing power parity (PPP)?

Ans X A. To account for variations in economic growth rates
o B. To reflect variations in the cost of living across countries
#< C. To account for differences in currency exchange rates

#< D. To standardise income levels across different population sizes

Question Type :

Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 1D :
Status :

Chosen Option :
Marks :

MCcQ
630680774311
6306803035148
6306803035147
6306803035145
6306803035146
Answered

B

1

Q.50 Trade credit allows for the acquisition of supplies without the need for immediate
payment and the buyer's records show this credit as:

Ans X A. perspective creditor
#< B. supply debtors
#5 C. advanced creditors

¢ D. sundry creditors

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

McQ
630680650766
6306802548040
6306802548041
6306802548039
6306802548038
Answered

B

-0.25

Section : Mental ability
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Q.51 Refer to the given series and answer the question that follows (all numbers are single
digit numbers only).

(Left)56269745185154734213784379 2 (Right)

How many such even digits are there, each of which is immediately preceded by an
odd digit and also immediately followed by an odd digit?

Ans X A7
X B.6
K C.8
& D.3

Question Type : MCQ
Question ID : 630680959438
Option 11D : 6306803761540
Option 21D : 6306803761539
Option 3 ID : 6306803761541
Option 4 ID : 6306803761538
Status : Answered
Chosen Option : D
Marks : 1

Q.52 P is the son of Z. Q is married to P. Y is the wife of Z. X is the brother of Y. W is married
to X. B is the father of Y. A is married to B. How is A related to Z?

Ans X A. Wife’s sister
#< B. Mother
5 C. Daughter
” D. Wife’s mother

Question Type : MCQ
Question ID : 630680285016
Option 11D : 6306801108040
Option 21D : 6306801108042
Option 3 ID : 6306801108041
Option 4 ID : 6306801108039
Status : Answered
Chosen Option : D
Marks : 1
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Q.53 In a certain code language, ‘WEAR’ is coded as ‘1537’ and ‘AIDS’ is coded as ‘6241°.
What is the code for ‘A’ in the given code language?

Ans AT
< B.6
K C.3
K D.4
Question Type : MCQ
Question ID : 630680959457
Option 11D : 6306803761614
Option 2 ID : 6306803761617
Option 3 ID : 6306803761615
Option 4 ID : 6306803761616
Status : Answered
Chosen Option : B
Marks : -0.25
Q.54 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusions logically follow(s) from the
statements.
Statements: Some kings are snakes. All butterflies are snakes.
Conclusion (l): Some kings are butterflies.
Conclusion (ll): All snakes are butterflies.
Ans X A.Both conclusions (I) and (ll) follow.
#5 B. Only conclusion (1) follows.
# C. Only conclusion (1) follows.
o D. Neither conclusion (1) nor (Il) follows.
Question Type : MCQ
Question ID : 630680916197
Option 11D : 6306803589927
Option 2 ID : 6306803589928
Option 3 ID : 6306803589929
Option 4 ID : 6306803589926
Status : Answered
Chosen Option : D
Marks : 1
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Q.55 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusion(s) logically follow(s) from the
statements.

Statements:
All shapes are squares.
All squares are rhombuses.

Conclusions:
(I) Some rhombuses are shapes.
(I) All shapes are rhombuses.

Ans ¢ A. Both conclusions (l) and (II) follow.
#5 B. Only conclusion (1) follows.
#5 C. Neither conclusion (1) nor (11) follows.

#5 D. Only conclusion (I1) follows.

Question Type : MCQ
Question ID : 630680917778
Option 11D : 6306803596271
Option 2 ID : 6306803596269
Option 3 ID : 6306803596272
Option 4 ID : 6306803596270
Status : Answered
Chosen Option : A
Marks : 1
Q.56 Seven boxes A, B, C, D, E, F and G are kept one above the other but not necessarily in
the same order. Only three boxes are kept above B. Only one box is kept between A
and B. Only three boxes are kept between A and C. C is kept at some place above B. G
is kept immediately below C. D is kept at one of the places above E. F is not kept
immediately above or below A. How many boxes are kept above G?
Ans X A.One
& B. Four
# C. Three
¢’ D. Two
Question Type : MCQ
Question ID : 630680942297
Option 11D : 6306803693835
Option 21D : 6306803693838
Option 3 ID : 6306803693837
Option 4 ID : 6306803693836
Status : Answered
Chosen Option : A
Marks : -0.25
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Q.57 Laki starts from Point A and drives 7 km towards south. He then takes a right turn,
drives 5 km, turns right and drives 9 km. He then takes a right turn and drives 8 km. He
takes a final right turn, drives 2 km and stops at Point P. How far (shortest distance)
and towards which direction should he drive in order to reach Point A again?

(Note: All turns are 90 degree turns only unless specified.)
Ans X A.1km to the south

5 B. 4 km to the west
o C. 3 km to the west
#< D. 2 km to the north

Question Type : MCQ
Question ID : 630680750147
Option 11D : 6306802940079
Option 2 ID : 6306802940082
Option 3 1D : 6306802940081
Option 4 1D : 6306802940080
Status : Answered
Chosen Option : C
Marks : 1

Q.58 Refer to the following number, symbol series and answer the question. Counting to be
done from left to right only.
(Left) @#786*$3%1#54279% $ @ 6 2 (Right)
How many such symbols are there each of which is immediately preceded by a
number and also immediately followed by another number?

Ans 7 A Two
4 B.One
X C.Four
& D. Three

Question Type : MCQ
Question ID : 630680375965
Option 11D : 6306801464934
Option 21D : 6306801464931
Option 3 ID : 6306801464933
Option 4 ID : 6306801464932
Status : Answered
Chosen Option : A
Marks : 1
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Q.59 Eachof P, Q, R, S, T, U and V has an exam on a different day of a week starting from
Monday and ending on Sunday of the same week. P has an exam on Tuesday. Exactly
three people have an exam between P and V. T has an exam immediately before U, and
R has an exam immediately after U. Only one person has an exam between T and S.
How many people have exams between P and R?

Ans X A.One
¢ B. Two
& C.Four
& D. Three

Question Type : MCQ
Question ID : 630680908587
Option 11D : 6306803559418
Option 2 ID : 6306803559419
Option 3 ID : 6306803559421
Option 4 ID : 6306803559420
Status : Answered
Chosen Option : D
Marks : -0.25

Q.60 In a certain code language,
F + H means F is the brother of H,
F - H means F is the sister of H,
F x H means F is son of H and
F + H means F is the daughter of H.
Based on the above, If M+ S - T+ Q x V, then how is Q related to M?

Ans X A. Brother
o B. Mother’s brother
< C.Son
#5 D. Father

Question Type : MCQ
Question ID : 630680746389
Option 11D : 6306802925697
Option 2 ID : 6306802925696
Option 3 ID : 6306802925699
Option 4 ID : 6306802925698
Status : Answered
Chosen Option : D
Marks : -0.25

Section : al ability test
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Q.61 if a and b, where a > b, are the roots of the equation 8x2-8x-6= 0, then what is the
value of (a - 2b)?

Ans 10
;A T
9
15
B
2
5
o C. —
2
5
X D. _
4
Question Type : MCQ
Question ID : 630680815611
Option 1 ID : 6306803195744
Option 2 ID : 6306803195742
Option 31D : 6306803195741
Option 4 ID : 6306803195743
Status : Answered
Chosen Option : B
Marks : -0.25
Q.62 Let x be the greatest number which, when divides 3403, 1403 and 3424, the remainders
are 18, 49 and 39, respectively. What is the sum of the digits of x?
Ans X A 36
X B.26
o C. 20
X D.6
Question Type : MCQ
Question ID : 630680954774
Option 11D : 6306803743307
Option 2 ID : 6306803743305
Option 3 ID : 6306803743304
Option 4 ID : 6306803743306
Status : Answered
Chosen Option : B
Marks : -0.25
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Q.63 The greatest number, which divides 1405 and 489 to leave 11 and 13 respectively as
remainders, is:

Ans X A.36
< B.32
o C.34
& D. 39
Question Type : MCQ
Question ID : 630680788730
Option 11D : 6306803090702
Option 2 ID : 6306803090701
Option 3 1D : 6306803090700
Option 4 ID : 6306803090703
Status : Answered
Chosen Option : C
Marks : 1
Q.64 Kalpana and Sudha got 765 and 522 marks respectively in an examination. If Kalpana
scored 85% marks, then what is the percentage of marks scored by Sudha?
Ans X A 59%
v 4 B. 58%
X C.61%
< D.56%
Question Type : MCQ
Question ID : 6306801021546
Option 11D : 6306804009234
Option 2 1D : 6306804009232
Option 3 ID : 6306804009235
Option 4 ID : 6306804009233
Status : Answered
Chosen Option : B
Marks : 1
Q.65 A shopkeeper marks an article at ¥x and offers a discount of 50% on it. He sells it for
¥399 after charging VAT of 52% on the discounted price. What is the value of ¥ x?
Ans X A.%600
< B. %500
/5 C.Z700
& D. 3525
Question Type : MCQ
Question ID : 630680844490
Option 11D : 6306803307888
Option 2 1D : 6306803307887
Option 3 ID : 6306803307889
Option 4 ID : 6306803307886
Status : Answered
Chosen Option : C
Marks : -0.25

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1/0SSC241/0SSC241S9D1351/17297514871767219/230738904...

69/75

?@ Teachingninja.in



10/28/24, 7:03 PM cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//0SSC241/0SSC241S9D1351/17297514871767219/...

the same work in 12 days is:

Q.66 24 men can do a piece of work in 46 days. The number of men required to complete

Ans X A.91
& B.89
&K C.94
o D. 92
Question Type : MCQ
Question ID : 630680948007
Option 11D : 6306803716723
Option 2 ID : 6306803716722
Option 3 ID : 6306803716721
Option 4 ID : 6306803716720
Status : Answered
Chosen Option : D
Marks : 1
Q.67 The average of 7 numbers is 45. If each number is increased by 5, what will the new
average be?
Ans X A 45
X B.55
X C7
& D. 50
Question Type : MCQ
Question ID : 630680656748
Option 11D : 6306802570935
Option 2 ID : 6306802570936
Option 3 ID : 6306802570937
Option 4 ID : 6306802570934
Status : Answered
Chosen Option : B
Marks : -0.25
Q.68 Write the expanded form of (3a + 8b + 6¢c)?.
Ans X" A 9a2 + 64b2 + 36c2 + 48ab + 91bc + 36ac
X B.9a + 64b + 36¢° + 48ab + 96bc + 46ac
X C.9a% + 64b? + 36¢2 + 52ab + 96bc + 36ac
o D. 9a° + 64b? + 36¢2 + 48ab + 96bc + 36ac
Question Type : MCQ
Question ID : 630680827379
Option 1 1D : 6306803240854
Option 2 1D : 6306803240853
Option 3 ID : 6306803240852
Option 4 ID : 6306803240851
Status : Answered
Chosen Option: C
Marks : -0.25
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Q.69 Amit invested a certain sum of money at 10% per annum simple interest. If he receives
an interest of ¥39996 after 6 years, the sum (in %) he invested is:

Ans X A.65685

75 B. 66960
 C. 66660
/< D. 66888
Question Type : MCQ
Question ID : 630680808921
Option 11D : 6306803169264
Option 2 1D : 6306803169265
Option 3 ID : 6306803169263
Option 4 ID : 6306803169266
Status : Answered
Chosen Option : C
Marks : 1
Q.70 Two trains having lengths of 280 m and 470 m are running at speeds of 60 km/h and
110 km/h, respectively, in the same direction. The time taken (in minutes) by the faster
train, coming from behind, to completely cross the other train is:
Ans X A.2
o B.0.9
/& C.03
& D.1
Question Type : MCQ
Question ID : 630680950247
Option 11D : 6306803725638
Option 2 1D : 6306803725637
Option 3 ID : 6306803725639
Option 4 ID : 6306803725640
Status : Answered
Chosen Option : B
Marks : 1
Section : Basic C uter literacy
Q.71 In MS Excel, if a user wants to enter the number ‘5000’ into a cell, which of the
following methods is correct?
Ans X A. Entering '5000.00' (with decimal points)
#5 B. Entering '5 000' (with a space)
¢ C. Entering '5000" (without a comma)
#5 D. Entering '5,000' (with a comma)
Question Type : MCQ
Question ID : 6306801052225
Option 11D : 6306804131264
Option 2 1D : 6306804131265
Option 3 ID : 6306804131263
Option 4 ID : 6306804131262
Status : Answered
Chosen Option : C
Marks : 1
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Q.72 Which of the following is commonly use to manage and analyze large datasets,
perform statistical analysis, and generate reports?

Ans ¢ A. Business Intelligence Application
/< B. Photo Editor
# C. Media player
# D. Word Processing Application

Question Type : MCQ
Question ID : 630680986258
Option 11D : 6306803869015
Option 21D : 6306803869013
Option 3 ID : 6306803869014
Option 4 ID : 6306803869016
Status : Answered
Chosen Option : D
Marks : -0.25

Q.73 Which of the following options is NOT used for checking spelling and grammatical
errors in Microsoft Word?

Ans X A. Go to the "Review" tab, then click on "Spelling and Grammar."
«” B. Press Ctrl+S.
< C.Press F7.

& D. Right-click on the text and choose "Check Spelling and Grammar" from the context
menu.

Question Type : MCQ
Question ID : 630680770596
Option 11D : 6306803020286
Option 2 1D : 6306803020288
Option 3 ID : 6306803020285
Option 4 ID : 6306803020287
Status : Answered
Chosen Option : B
Marks : 1

Q.74 Which icon on the desktop represents a temporary holding place for files that are
deleted?

Ans X A. My Computer
#< B. Wallpaper
” C. Recycle Bin
#< D. Taskbar

Question Type : MCQ
Question ID : 630680767877
Option 11D : 6306803009772
Option 2 ID : 6306803009771
Option 3 1D : 6306803009770
Option 4 1D : 6306803009769
Status : Answered
Chosen Option : C
Marks : 1
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Q.75 What is the default width of a column in MS Excel?
Ans X A.2characters

o B. 8.43 characters
#< C. 4 characters
X D. 16 characters

Question Type : MCQ
Question ID : 630680773052
Option 11D : 6306803030185
Option 2 1D : 6306803030187
Option 3 ID : 6306803030186
Option 4 ID : 6306803030188
Status : Answered
Chosen Option: C
Marks : -0.25
Q.76 Which of the following methods can be used to insert a video file into a PowerPoint
slide in MS Office PowerPoint 2007?
Ans X A. Go to the 'File' tab -> Click on 'Open' -> Choose the video file
#5 B. Go to the 'Design’ tab -> Select 'Insert Video' -> Browse for the video file on your
computer
¢ C. Go to the 'Insert’ tab -> Click on 'Movie' -> Select 'Movie from file' to add a video
# D. Right-click on the slide -> Select 'Insert' -> Choose 'Video from Text Box'
Question Type : MCQ
Question ID : 6306801049511
Option 11D : 6306804120293
Option 2 1D : 6306804120294
Option 3 ID : 6306804120292
Option 4 ID : 6306804120295
Status : Answered
Chosen Option: C
Marks : 1
Q.77 In modern CPUs, which of the following techniques is primarily used to increase
instruction-level parallelism and improve processing efficiency?
Ans X A. Virtualisation
o B. Pipelining
# C. Caching
&5 D. Hyperthreading
Question Type : MCQ
Question ID : 6306801056045
Option 11D : 6306804146688
Option 2 ID : 6306804146686
Option 3 ID : 6306804146687
Option 4 ID : 6306804146689
Status : Answered
Chosen Option : A
Marks : -0.25
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Q.78 Modern mobile phones and tablets utilise specialised operating systems optimised for
touchscreen interfaces and resource constraints. Which of the following statements
correctly describes a key distinction between Android and iOS operating systems in
terms of software distribution and system architecture?

Ans X A.Android devices exclusively use ARM architecture processors, while iOS devices are
capable of using both ARM and x86 architecture processors.

&5 B. iOS provides full customisation of the system interface, while Android is restricted to
manufacturer-defined interfaces.

o C. Android supports third-party app stores and is based on the open-source Linux

kernel, while iOS restricts app distribution to the Apple App Store and is built on a closed-
source UNIX architecture.

#5 D. Both Android and iOS are open-source operating systems that allow installation of
apps from multiple sources.

Question Type :
Question ID :
Option 11D :
Option 21D :
Option 31D :
Option 4 ID :

Status :

Chosen Option :

Marks :

MCcQ
6306801058284
6306804155521
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Q.79 Rahul has created a presentation. There are two slides in his presentation that he does
not want to appear during the slide show. What should he do?

Ans X A. Add special effects to the two slides
¢ B. Hide the slides
#5 C. Create a new presentation

< D. Delete the two slides

Question Type :
Question ID :
Option 11D :
Option 211D :
Option 31D :
Option 41D :

Status :

Chosen Option :

Marks :

McQ
630680787714
6306803086662
6306803086661
6306803086663
6306803086660
Answered

B

1

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1/0SSC241/0SSC241S9D1351/17297514871767219/230738904...

74175

?@ Teachingninja.in



10/28/24, 7:03 PM cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//0SSC241/0SSC241S89D1351/17297514871767219/...

o B. Click on File > New
#< C. Click on File > Print
& D. Click on File > Open

Q.80 Which of the following is the first step in creating a new MS Word document?
Ans X A. Click on File > Save As
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